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Who Should Read This

This paper has been written for developers and project managers who want to ensure code quality by using Check-in Policies

Readers should be familiar with parts of .NET Development and Visual Studio Team System, such as:

· Source Control (Checking files in and out)

· C#
Introduction
SSW (www.ssw.com.au) is a software development shop providing solutions based on Microsoft technologies to our clients. We are better known for our coding rules and practices (www.ssw.com.au/ssw/Standards). The rules are there to ensure higher code quality in the code that we produce. We have a popular tool for .NET developers called SSW Code Auditor (www.ssw.com.au/ssw/CodeAuditor) that helps us implement these rules plus many internal rules.

One of the problems we had before Team Foundation Server (TFS) was that SSW Code Auditor was a separate executable. This meant that it was up to the developers to run the tool. So how do we ensure that our developers are producing quality code? 

Join us on a journey of how we solve this problem and how you can do the same. 

You will see that this is where Microsoft Visual Studio Team System comes into its own – it is a platform aimed at increasing the robustness and predictability of code. That is why there are several inbuilt tools to help ensure quality code:

· Unit Test Manager, 

· Code Coverage Reports, 

· Static Code Analysis (was FxCop)

· Dynamic Code Analysis (intellisense), 

· Code Profiling
· Instrumented – full profiling of the application
· Sampling – polling the applications
· and Check-in Policies.
While these built in tools are great, Microsoft has left the door open for developers to customize a great deal of these tools.

In this article, the focus will be on the last point being Check-in Policies and how to write a custom Check-in Policy to enforce coding standards. A Check-in Policy refers to a policy that should be satisfied before code is permitted to be checked into source control. For example, Visual Studio Team System comes with a Check-in Policy called “Testing Policy” that “Ensures that tests from specific test lists are successfully executed before checking in.” This is a powerful policy that makes it a requirement that all code your developers want to check-in must pass a series of unit tests before they are allowed to commit those changes into source control.

Using this concept we are going to explore developing addition check-in policies, producing better quality code and changing the world developers work in on a daily basis.
Note: The developers also have the option to “Override policy failure and continue check-in” but they must specify a reason for overriding the policy failure.

About the Authors

This article is written by Adam Cogan (SSW Chief Architect and Microsoft Regional Director) and Eric Phan (Senior Software Developer) of SSW (www.ssw.com.au). SSW is a Sydney based consulting company specializing in .NET solutions for progressive businesses since 1990. SSW offers custom software solutions in ASP.NET, VB.NET, C#, SQL Server, Exchange Server, Microsoft Access and Office 2003. 

Adam Cogan’s Profile

http://www.ssw.com.au/SSW/Employees/employeesprofile.aspx?EmpID=AC
Eric Phan’s Profile http://www.ssw.com.au/SSW/Employees/employeesprofile.aspx?EmpID=EP
A world without check-in policies

A common problem with developers is that they tend to get side tracked. As they are working on a particular task they might see some code that to them seems bad and fix it while they’re working on a task.

For example, say that the developer adds this line of code as a fix:

Thread.Sleep(10000);

The developer then right clicks and checks in the changes. A few weeks down the track the same developer or another developer looks at the code and wonders why this line of code was put there. Why is it there? What is it fixing?

It would be great if code can’t be checked in unless it’s related to a task or work item – that way, you make sure that your developers are sticking to the task that’s been assigned and the original task can always be brought up to put the code changes in context.

Setting up your first Check-in policy to associate code to a Work Item

So how does a project manager make sure that their developers are working on tasks that have been given to them and not working on unrelated code? With TFS this is where check-in policies come into play. Begin by setting up a check-in policy to solve the above problem.

TIP: If you don’t see a Team Explorer window in Visual Studio Team System then try the following:

· Install Team Explorer. 
· Either from the VSTS disc or
· You can download this from MSDN (http://download.microsoft.com/download/2/a/d/2ad44873-8ccb-4a1b-9c0d-23224b3ba34c/VSTFClient.img) 
· Go to View > Team Explorer
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Figure 1 - Open the Team Explorer Window
Note: Team Explorer is the plug-in for Visual Studio Team System to connect to Team Foundation Server. It’s a separate executable because Microsoft shipped TFS much later than Visual Studio Team System.
In the Team Explorer window:
1. Right click on the TFS Server (UNICORN in this case - See Figure 2)

2. Click New Team Project
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Figure 2 - Create a new Team Project

3. On the Specify the Team System Settings page type in Northwind for the project name (See Figure 3)
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Figure 3 - Specify Northwind as the Project Name

4. Click Next
5. Click Finish
6. Click Close
You will now see a new project called Northwind in the Team Explorer window (See Figure 4)
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Figure 4 - Northwind Team Project created
7. Right click the Northwind Team Project that you just created (See Figure 5)
8. Select Team Project Settings 
9. Select Source Control
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Figure 5 - Configuring Source Control settings to enable Check-in Policies

10. This will bring up a Source Control Settings dialog (See Figure 6)
11. Click the Check-in Policy tab
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Figure 6 - Check-in Policy tab

12. Click Add
[image: image7.png]ource Control Settings - Horthwind

ot seings | Chedeinpole | chacin s |

Polcy Type

Chedken pocy:

[Add Check-in Policy 2% Edit

| bescripton

If

gemove

[Code Anaiysis

- Desaription

every checen.

ey Ensble

“This policy requires that one or more work tems be assodated with

Dssble

[

==l
)

e |e=] |




Figure 7 - Add Check-in Policy dialog
13. Select Work Items (See Figure 7)
14. Click OK
15. Click OK on the Source Control Settings dialog

You have now set up your first check-in policy. From now on, whenever a developer checks in code into source control they will first have to associate the checked in files with one or more work items.

Testing your first Check-in Policy

Now that the policy is in place for the Team Project, you need to make sure that it works. The first thing is to create a project and check it into source control under Northwind.

1. Click File > New > Project (See Figure 8)
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Figure 8 - Create a new Project

2. Select a Windows Application with the following settings (See Figure 9)
a. Note: Check Add to Source Control
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Figure 9 - New Project settings - Remember to check "Add to Source Control"

3. You will be presented with an Add Solution to Source Control dialog. (See Figure 10)
4. Select Northwind
5. Click OK
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Figure 10 - Add your Northwind Project to source control

Your Solution Explorer will look like Figure 11
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Figure 11 - New files in Source Control
6. Right click the Solution

7. Click Check In (See Figure 12)
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Figure 12 – Attempt to Check In files
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Figure 13 - Check In dialog

8. Click Check In (See Figure 14)
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Figure 14 - Policy Failure warning! (Our policy works)
To satisfy the policy you must click on the Work Items button and select a work item to associate with the check-in. 

1. Select the Work Items tab on the left

2. Select the highlighted work item

3. Click Check In (See Figure 15)
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Figure 15 - Associate Work Items before checking in
TIP: If there are no work items then click the ellipsis button (…) and from Team Queries, select All Work Items
As you can see, you now can no longer check in code without it being associated with a work item. You can do the same thing for Code Analysis or Testing Policy

WARNGING: Code Analysis is only available in Visual Studio Team System for Software Developers.
A piece of code I’d never let a developer write

See this code:

private static void myfunction()

{

    try

    {

        ProcessBatches();

    } 
    catch (Exception ex)

    {

    }

}

This is an empty catch block with is essentially the same as an “on error resume next” in VB. This code compiles fine, but I’d love to create a policy that didn’t allow developers to do this. SSW Code Auditor will find this particular problem, however the problem is that SSW Code Auditor isn’t integrated into VSTS.
Let’s create a third party check-in policy that makes code like this a thing of the past.
Creating your first check-in policy

Now that you’ve set up a few policies in our Team Project, you want to make sure that our coding standards are followed. You goal is to add an extra check into the Add Check-in Dialog for SSW Code Auditor (See Figure 16)
[image: image16.png]Checkin policy:

[Testng Foicy
Viork Items

Descrpton

“This policy wil checkif the developer his gotten Code Audtor to zero
on the code they are checking

Northwind.

C Code- No empty code biocks Which gives us this check-in
= Code- SQL stored procedure names should be prp =-Violation..

C= Code- Structs and Classes member accessbilty
(€2 LI MonthCalendar FrstoayOftiesk mst be Monday (T: Fix i cesigner) fles/D:/Dataricphan/ssii/.

(€ Ul- MonthCalender must ot have ShonTocdzy or ShonTodayCirde set o fase (Tp: Fixin designer.) fes/
(C2VB.NET Cocie Message box tte must be the sppicaton'sproduct name and verson only (Tp: Fix n coce.
|C/VB.NET Code- MessageBoxes must have icons (Tip: Fix i code.) fies///Di/DataEricPhan/SSW Northvind].
(C#/VB.NET Cotie- P Theme - Should not use Applicaton EnableVisualStyes(Tio: Comment out n code) fie/





Figure 16 - Our goal is to have a SSW Code Auditor Check-in Policy that will catch bad code like we saw before
Background Information

Before jumping into writing a custom Check-in policy, there are a few things you need to understand first. The first of which is “How do you create a custom check-in policy?”

Well, Microsoft has provided several APIs for customizing Visual Studio Team System. The ones you’ll be using are:

· IPolicyDefinition – information used in the Add Check-In Policy UI

· IPolicyEvaluation - validation logic called by TFS on the code that is checked in
TIP: The DLL where these two interfaces are defined is located in “C:\Program Files\Microsoft Visual Studio 8\Common7\IDE\PrivateAssemblies\Microsoft.TeamFoundation.VersionControl.Client.dll”

IPolicyDefinition

The IPolicyDefinition interface is used by the Add Check-in Policies dialog to display information on the Checkin Policy. See Figure 17 for a class diagram of the interface.
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Figure 17 - IPolicyDefinition Interface

Each property in the interface is used by the UI as follows:

· Type – is the name of the check-in policy (See Figure 19)

· TypeDescription – the description of the policy (See Figure 19)

· Description – description displayed in the Source Control Settings dialog (See Figure 20)

· InstallInstructions – message that gets displayed when a developer does not have the custom check-in policy (See Figure 21)
· CanEdit – a Boolean flag saying whether the Edit button should be enabled on the Source Control Settings dialog (See Figure 20)
The Edit method is called when the user clicks on the Edit button on the Source Control Settings dialog. (See Figure 18 & Figure 20)

For our custom check-in policy you will not need to use the Edit method, but you can use it to display a dialog like in Figure 18.
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Figure 18 - Dialog that displays when Edit is clicked for Code Analysis Check-in Policy
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Figure 19 - Type and TypeDescription are used in the Add Check-in Policy dialog
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Figure 20 - Edit (currently disabled) and Description are used in the Source Control Settings dialog
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Figure 21 – Policy Error and Install instructions when a developer doesn't have a check-in policy – this will happen if a developer doesn’t have the check-in policy installed
IPolicyEvaluation

The IPolicyEvaluation interface is used to perform the actual validation on the code when the developer tries to check in files. See Figure 22 for a class diagram of the interface.
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Figure 22 - IPolicyEvaluation Interface

This interface consists of four methods:

· Activate -  is called when the user double clicks a failed policy in the tools window

· DisplayHelp - shows a help message

· Evaluate - is called to check the files against the policy

· Initialize - occurs when the object is instantiated, and contains a list of pending check-ins.

The method you’ll be looking at most is Evaluate – that’s where all the validation logic goes.

Building the skeleton of your custom check-in policy

To create your own custom Check-in Policy you need to create a class that implements both the IPolicyDescription and IPolicyEvaluation interfaces.

1. Create a new class library in c:\temp\CodeAuditorCheckinPolicy called CodeAuditorCheckinPolicy
2. Create a new class called CodeAuditorCheckinPolicy
3. Add a reference to Microsoft.TeamFoundation.VersionControl.Client.dll
TIP: The DLL is located in “C:\Program Files\Microsoft Visual Studio 8\Common7\IDE\PrivateAssemblies\Microsoft.TeamFoundation.VersionControl.Client.dll”

4. Add a using statement at the top of the CodeAuditorCheckinPolicy class

using Microsoft.TeamFoundation.VersionControl.Client;
5. Implement the IPolicyDescription and IPolicyEvaluation interfaces

a. Type the italicized code in:

public class CodeAuditorCheckinPolicy : IPolicyDefinition, IPolicyEvaluation

{

}

b. Hover over the smart tag below IPolicyDefinition (See Figure 23)
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Figure 23 - IPolicyDefinition Smart Tag
c. Click it

d. Click Implement interface IPolicyDefinition (See Figure 24) 
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Figure 24 - Implement the Interface
e. Do the same for IPolicyEvaluation

This will create stub methods for the methods in the interface that you will have to implement. Your class diagram for the CodeAuditorCheckinPolicy will now have the following methods and properties in Figure 25.
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Figure 25 - Class Diagram for CodeAuditorCheckinPolicy
TIP: To view your class as a diagram: Right click the CodeAuditorCheckinPolicy class in Solution Explorer and select View Class Diagram
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Figure 26 - Viewing a class diagram
Filling in the Blanks #1 – IPolicyDefinition

Now that you’ve made your class implement the correct interfaces, you need to fill in the properties and methods that have been generated.

Start by implementing the properties from the IPolicyDefinition interface and test if it comes up in the Add Check-in Policy dialog.

IPolicyDefinition Properties

1. Fill in the following properties and methods with the code in italics. 
        #region IPolicyDefinition Members

        /// <summary>

        /// Gets the description of the policy for the Check-In Policy Dialog

        /// </summary>

        public string Description

        {

            get { return "This policy will check if the developer has gotten Code Auditor to zero on the code they are checking in"; }

        }

        /// <summary>

        /// Gets if the policy is editable

        /// </summary>

        public bool CanEdit

        {

            get { return false; }

        }

        /// <summary>

        /// This allows a UI to be displayed when the Edit button is .

        /// clicked

        /// </summary>

        /// <param name="policyEditArgs"></param>

        /// <returns></returns>

        public bool Edit(IPolicyEditArgs policyEditArgs)

        {

            return false;

        }

        /// <summary>

        /// This contains a description on how to install the plugin if 

        /// it is not already installed on the system. This value is 

        /// sotred in the TFS server along with the policy

        /// </summary>

        public string InstallationInstructions

        {

            get { return "To install this policy, download it from the project portal and register it with Visual Studio"; }

        }

        /// <summary>

        /// This string is the name of our policy. 

        /// </summary>

        public string Type

        {

            get { return "SSW Code Auditor" }

        }

        /// <summary>

        /// This string is a description of our policy.

        /// </summary>

        public string TypeDescription

        {

            get { return "This policy will check if the developer has gotten Code Auditor to zero on the code they are checking in"; }

        }
2. To make sure that everything is in order, build the solution – this will create a DLL in the c:\temp\CodeAuditorCheckinPolicy\CodeAuditorCheckinPolicy\bin\Debug\CodeAuditorCheckinPolicy.dll
So what you’ve done so far is fill in the properties and methods for the IPolicyDefinition interface. This means that Visual Studio will now know what to display in the Add Checkin-Policy dialog for your check-in policy.

Testing your Policy

To test your policy, you need to first register it with Visual Studio so that it is aware of your custom check-in policy. To do this:

1. Copy the c:\temp\CodeAuditorCheckinPolicy\CodeAuditorCheckinPolicy\bin\Debug\CodeAuditorCheckinPolicy.dll to c:\MyCheckinPolicies\
2. Open RegEdit (Start > Run > regedit)
3. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\VisualStudio\8.0\TeamFoundation\SourceControl\Checkin Policies
4. Add a new string called CodeAuditorCheckinPolicy
5. Double click the new string and add the path to the DLL as the value: c:\MyCheckinPolicies\CodeAuditorCheckinPolicy.dll
This will allow Visual Studio to know about your custom check-in policy. So to check if it’s there:
1. Start a new instance of Visual Studio

2. In the Team Explorer window right click the Northwind Team Project > Team Project Settings > Source Control 

3. Select the Check-in Policies tab

4. Click Add

5. SSW Code Auditor will now appear in the Add Check-in Policy dialog (See Figure 27)
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Figure 27 - Success! Our custom check-in policy now appears in the Add Check-in Policy dialog

6. Click OK – this will enable the SSW Code Auditor Check-in Policy for the Northwind Team Project

7. Shutdown the new instance of Visual Studio.

Filling in the Blanks #2 – IPolicyEvaluation

Now that TFS knows about your custom check-in policy, it’s time to put the logic in to actually check your code. So in this section, you’ll be implementing the methods in IPolicyEvaluation.

Initialize()

The Initialize method is important because from this method we get a handle on the files that are being checked in. You need to first create a private variable to store the pending check-ins.
        /// <summary>

        /// Stores a list of pending checkins

        /// </summary>
        private IPendingCheckin m_PendingCheckin;

Next store the pending check-ins and add an event handler to handle when pending check-ins change (i.e. when the user modifies the file, then re-evaluate it)

        /// <summary>

        /// Gets called when the policy is first instanciated.

        /// </summary>

        /// <param name="pendingCheckin">A list of pending checkins</param>

        public void Initialize(IPendingCheckin pendingCheckin)

        {

            m_PendingCheckin = pendingCheckin;

            // Register an event handler to handle when the files 

            // being checked in changes

            m_PendingCheckin.PendingChanges.CheckedPendingChangesChanged += new EventHandler(PendingChanges_CheckedPendingChangesChanged);

        }

        /// <summary>

        /// Event handler for changes in the files being checked in.

        /// </summary>

        /// <param name="sender"></param>

        /// <param name="e"></param>

        void PendingChanges_CheckedPendingChangesChanged(object sender, EventArgs e)

        {

            OnPolicyStateChanged(Evaluate());

        }

        private void OnPolicyStateChanged(PolicyFailure[] policyFailure)

        {

            if (PolicyStateChanged != null)

            {

                PolicyStateChanged(this, new PolicyStateChangedEventArgs(policyFailure, this));

            }

        }

        public event PolicyStateChangedHandler PolicyStateChanged;

Evaluate()

This is the method that does the actual checking of files for compliance with SSW Code Auditor rules. The first thing you have to do is add a reference to the SSW Code Auditor dlls.

1. Right click CodeAuditorCheckinPolicy Solution Explorer

2. Add a Reference to the following SSW Code Auditor DLLs

· SSW.CodeAuditor.Business

· SSW.CodeAuditor.Common

· SSW.CodeAuditor.Data

· SSW.Registration

TIP: These DLLs can be located in your SSW Code Auditor program folder

Now that you have a reference to SSW Code Auditor Business logic you can use it to check our code. Add the following using statements:

using System;

using Microsoft.TeamFoundation.VersionControl.Client;

using SSW.CodeAuditor.Business.Rules;

using SSW.CodeAuditor.Business.Targets;

using SSW.CodeAuditor.Business; 

using System.Collections.Generic;

using System.Text;

Now you can implement our Evaluate Function. What you want this function to do is:

1. Check to see if it can find the SSW Code Auditor Database

2. If it can’t then return that as the reason for the Policy’s failure

3. If it exists then generate a policy failure for each rule that’s been broken and return that set of failures.

/// <summary>

// Path to SSW Code Auditor Database

/// </summary>

private const string SSW_CODE_AUDITOR_DB_PATH = @"C:\Program Files\SSW Code Auditor\SSWCodeAuditor2000.mdb";

public PolicyFailure[] Evaluate()

{

    // Check if the SSW Code Auditor database exists

    if (!System.IO.File.Exists(SSW_CODE_AUDITOR_DB_PATH))

    {

        // No database found

        return new PolicyFailure[1] { new PolicyFailure("The SSW Code Auditor database could not be found, be install SSW Code Auditor from www.ssw.com.au/ssw/CodeAuditor", this)};

    }
    // Setup Code Auditor

    CodeAuditorApplication.Instance.ReloadDatabase(SSW_CODE_AUDITOR_DB_PATH);

    // Create a new job

    Job newJob = Job.CreateNew();

    newJob.JobName = "CodeAuditorCheckinPolicyJob";

    newJob.Notes = "This job is used by the SSW Code Auditor Check-in Policy to check pages for violations";

    newJob.IsShowNotes = true;

    // Add the file paths

    foreach (PendingChange pc in m_PendingCheckin.PendingChanges.CheckedPendingChanges)

    {

        Path p = Path.CreateNew(newJob);

        p.PathType = PathTypes.File;

        p.PathLocation = pc.LocalItem;

        p.Enabled = true;

        p.isRecurse = false;

    }

    List<ITarget> targets = newJob.GetTargets();

    SSW.CodeAuditor.Business.Rules.Rule[] rules =

    CodeAuditorApplication.Instance.GetRules();

    // Find the appropriate rules to use

    foreach (Rule r in rules)

    {

        foreach (ITarget t in targets)

        {

            if(r.CanCheckByName(t))

            {

                // Add to job

               JobRule.CreateNew(newJob, r);

               break;

            }

        }

    }

    // Run Code Auditor

    JobResult result = newJob.Execute();

    if (result.Statistics.FailedFiles > 0)

    {   

        List<PolicyFailure> pf = new List<PolicyFailure>();

        foreach (RuleResult rr in result.RuleResults)

        {

            // Get a description of the rule

            Rule r = GetRule(rr.RuleId);

            // If no rule is found then skip this one

            if (r == null) 

            {

                continue;

            }

            else

            {

                // Parse the line numbers

                StringBuilder lineNumbers = new StringBuilder();

                for (int i = 0; i < rr.LineNumbers.Count; i++)

                {

                    if (i == 0)

                    {

                        lineNumbers.Append("Line: ");

                    }

                    lineNumbers.Append(rr.LineNumbers[i].LineNumber.ToString());

                    if (i != rr.LineNumbers.Count- 1)

                    {

                        lineNumbers.Append(",");

                    }

                }

                string message =

                string.Format("{0} {1} {2}", r.RuleName, rr.Filename, lineNumbers.ToString());

                pf.Add(new PolicyFailure(message, this));   

            }

        }

        return pf.ToArray();

    }

    else

    {

        // No errors

        return new PolicyFailure[0];

    }

}

/// <summary>

/// Retrieves a rule from the Code Auditor Rule set

/// </summary>

/// <param name="ruleID">The ID of the Rule to retrieve</param>

/// <returns>The rule with the specified ID</returns>

private Rule GetRule(int ruleID)

{

    foreach (Rule r in CodeAuditorApplication.Instance.GetRules())

    {

        if (r.RuleId == ruleID)

        {

            return r;

        }

    }

    return null;

}

You’ve just implemented the evaluation function. It calls SSW Code Auditor by DLLs and checks the files that are currently being checked in. If any non-standard complaint code is found then it will be added to the PolicyFailure list. This list will be shown in the Policy Warnings tab on the Check-in dialog (See Figure 28).
[image: image28.png](Check In - Policy Warnings

=
Ix

) TF10135: The following checkein polices have not been satified

Descripton

C Code- Catch Exception must be more specific (Tp: Don' catch 'xcepton’only.) fle:/fc:tempNorthwing.
C Code- No empty catch blocks (Tp: Fix in code.) fils/ffc/temp Northind Northwind Mindonsul Program.
C Code- No empty code blocks (Tip: Fix in cod.) fie:/c:/tempNorthwinNor thwind WindowsU1 Program.

€= Code- SQL stored procedure names shouid be prefixed with the owner (dbo) (Tips Fix i Sal server and th,
€ Code- Structs and Clssses member accessibiity must be dedlared (Tip: Fix i cods) fies///: temp North.
€ UL MonthCalendar FirstDayOfiesk must be Monday (Tip: Fix in designer.) fle://c:tempNorthwsing Nor
€= UL MonthCalendar must not have ShonToday or ShoxTodayCrc set to flse (Tp: Fx n designer.) fie:.

(C2/VB.NET Code- Message box tile must be the spplication's product name and version only (Tip: Fix i coce.
(C#/VB.NET Code- MessageBoxes must have icons (Tip: Fx i code. ) fies/jc:tempNortwinNorthind Wi,
C2/VB.NET Code- XP Theme - Should not use Application.EnableVisualStyles{Tip: Comment out in code) fle/.





Figure 28 - Check-in Dialog with Code Auditor Policy Warnings

Other Functions

There are two remaining functions that you need to implement:

· DisplayHelp() – Displays a help message

· Activate() – Occurs when a policy warning is double clicked (See Figure 28)

/// <summary>

/// This function handles the double click event when a user double clicks a failed policy.

/// </summary>

/// <param name="failure"></param>

public void Activate(PolicyFailure failure)

{

    MessageBox.Show("The code you want to check in is not Code Auditor compliant. Please get Code Auditor to zero before trying to check these files in", "SSW Code Auditor", MessageBoxButtons.OK);

}
/// <summary>

/// Displays help when the user hits "F1" when a policy failure is active in the UI.

/// </summary>

/// <param name="failure"></param>

public void DisplayHelp(PolicyFailure failure)

{

    MessageBox.Show("The code you want to check in is not Code Auditor compliant. Please get Code Auditor to zero before trying to check these files in", "SSW Code Auditor", MessageBoxButtons.OK);

}

/// <summary>

/// Clean up after we’re finished using the dll.

/// </summary>

public void Dispose()

{

    m_PendingCheckin.PendingChanges.CheckedPendingChangesChanged -= new EventHandler(PendingChanges_CheckedPendingChangesChanged);

    m_PendingCheckin = null;

}
The last step is to build and make sure everything builds correctly. You’re now ready to test our plug-in.

Testing your custom Check-in Policy
Before you begin, you need to copy the new DLLs to your check-in policies folder.

1. Copy the c:\temp\CodeAuditorCheckinPolicy\CodeAuditorCheckinPolicy\bin\Debug\CodeAuditorCheckinPolicy.dll to c:\MyCheckinPolicies\
2. Start a new instance of Visual Studio

3. Open the Northwind Solution that we created on Page 1
4. Add the following code to Program.cs
using System;

using System.Collections.Generic;

using System.Windows.Forms;

namespace WindowsUI

{

    static class Program

    {

        /// <summary>

        /// The main entry point for the application.

        /// </summary>

        [STAThread]

        static void Main()

        {

            Application.EnableVisualStyles();

            Application.SetCompatibleTextRenderingDefault(false);

            Application.Run(new Form1());

        }

        private static void myfunction()

        {

            try

            {

                MessageBox.Show("asdf");

            } catch (Exception ex)

            {

            }

        }

    }

}
5. Check-in Program.cs
6. You will be presented with the Check-In dialog
7. Click Check In (See Figure 29)
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Figure 29 - Check-In dialog

8. A warning message will show up saying that there were policy failures (See Figure 30)
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Figure 30 - Code Auditor Policy Failures

Your custom check-in policy is now in place. You can now ensure that any code that your developers check in is compliant with SSW coding standards. 

Deploying the Policy
Now that the policy has been set up on our TFS server, what’s left to do is deploy your custom check-in policy to the developers. One caveat in TFS is that it does not automatically install the check-in policies on the developer’s machine. This is a manual process that you covered in “Testing your Policy” that involved creating a new registry key.

When a developer attempts to check in code and they do not have the custom check-in policy a popup appears with the installation instructions that we specified in the IPolicyDefinition interface. (See Figure 21)
What we’ve done to remedy this is to put the deployment of the check-in policy into the SSW Code Auditor application as a menu item (See Figure 31). That way, the developers can set up the policy with one or two clicks and not have to worry about the registry.

[image: image31.png]=101x]

Welcome to
SSW Code Auditor

Keep your code *healthy*
with SSW Code Auditor

re youlooking to eradicate bugs and ensure.
consistency? SSW Code Auditor is a tool that
allows developers o take control of yourcode,
ensuing large, complex source code can be.
simplified, cleaned and maintained. The bult-in
rules focus onthe most popular NETlanguages
(C#, VB.NET) for both Windows Forms and
ASPINET; however, the lebility of SSW Code:
‘Auditor allows the developerto add their own
rules to target any language or file.

More

[ send information to SSW for product improvement

B [





Figure 31 - Deploy the check-in policy using SSW Code Auditor

Conclusion

Code quality is important to any software development shop Visual studio helps us out with these things:

1. Dynamic Code Analysis

2. Associate Work Items with Code

3. Running unit tests before check-in

4. Static Code Analysis
We’ve seen how we can extend these further to integrate third party applications and force them into the build process by check-in policies

In this article, we looked at implementing the IPolicyDefinition and IPolicyEvaluation interfaces to create our own SSW Code Auditor check-in policy. There were 5 properties and 5 methods that we had to implement, with all the evaluation logic housed in the Evaluate() function. You can write your own custom check-in policies by following these exact same steps. You just need to write the evaluation function for the custom check-in policy.

At SSW, we’re known for our rules and our code quality; we’re always looking for new rules so read our standards (www.ssw.com.au/ssw/standards) and tell us what we’re missing) 
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